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Introduction

Auslogics Disk Defrag Professional is an essential tool for optimizing
and maintaining your hard disks. The program will defragment files,
consolidate free space and optimize file placement to make your
hard disks run at peak performance.

This professional version of the program is equipped with more
advanced features, such as extensive customization options for
defragmenting, optimizing and scheduling tasks; informative
reports and descriptions - every single feature or action is described
in detail, interactive cluster maps allow you to click on individual
blocks to view files located in them along with their status and an
option to defragment individually.

Disk Defrag Professional comes with four different types of
optimization techniques (by Prefetch layout, by last file access or
change time, and by disk zone), as well as a capability to
defragment locked system files (such as Windows Paging,
Hibernation, MFT and Registry files).

While default options allow you to perform operations with a click

g Auslogics Disk Defrag Professional

Action

View Settings Help

E Disks L% Reports

Mame

£L Local Disk (C)
¢ Local Disk (D)

[ Analyze ] [ Defrag

[T [ [ [
—_—
==

[ [ |

] | |[— ] ]

of a button, you can be in control of the program’s every action through settings that can be easily

adjusted.

Here is a brief overview of the features that allow the program to optimize and improve your system

performance:

Feature Description

File defragmentation

Defragments files and folders by merging their pieces together

Free space consolidation . .
fragmentation of newly created files

Merges scattered pieces of free space into a contiguous block, preventing

Smart file placement

Optimizes file placement on disks based on custom-defined criteria

Offline defragmentation . .
during normal system operation

Runs at boot time to defragment system and other files that are locked

Fragmentation prevention

Can leave small sections of free space next to user-defined frequently

modified files to prevent their fragmentation

INTRODUCTION



Feature

Description

Single file defragmentation

Can save your time by defragmenting only files that you want to, instead
of defragmenting an entire hard drive.

Simultaneous
defragmentation

Can defragment several drives at once, greatly reducing the time needed
for defragmentation

SSD-optimized algorithm

Reduces the number of write operations during standard defragmentation
to minimize wear of SSD drives

VSS-optimized algorithm

Minimizes growth of the VSS storage area and reduces the chance of
overwriting previous VSS snapshots

Auto-Defragmentation

Can defragment disks automatically in the background when your system
goes idle

Scheduled defragmentation

Has a flexible scheduler that allows you to set the most suitable time span
for defragmenting disks

Defragmentation wizard

The Wizard will recommend the best defrag options based on the way you
use your computer

Resource usage management

You can restrict the use of system resources by the defrag process to
minimize interference with your other activities

Clearing temporary files

Can clear current user and Windows temporary folders to lessen the time
needed for defragmentation

Disks error fixing

Can check disks for errors, give detailed report on errors found and fix
user-selected or all errors to prevent data loss or corruption

File fragments viewer

Shows you the list of all fragmented files and their fragments location on
the disk

File/Folder exclusion

If there is encrypted data or other files that should not be moved, they can
be excluded from defragmentation

Large fragments handling

Can be configured to ignore large file fragments as their defragmentation
doesn't increase file read speed much

Multi-terabyte volumes
support

Has a powerful engine that allows the program to defragment large disks
of several terabytes

Power saving for laptops

Can be configured to limit use of system resources when laptop runs on
battery power

Comprehensive reports and
disk performance charts

Will provide detailed reports of all operations performed and clear charts
that allow to track performance improvements

INTRODUCTION -



Installing the Program

System Requirements

Before installing the program, check that your computer meets the following hardware and software
requirements:

Operating System Minimal Hardware Configuration

Windows 7 (32-bit and 64-bit supported) 25 MB of available hard-disk space

Windows Vista (32-bit and 64-bit supported) 256 MB RAM or more for Windows XP

Windows 2008 (32-bit and 64-bit supported) 512 MB RAM or more for other Windows versions

Windows XP (32-bit and 64-bit supported)

Installation

It is recommended that you close all other applications when running the Setup so that they do not
interfere with the installation.

1. Start the Setup Wizard by

double-clicking on the

downloaded file. Welcome to the Auslogics Disk
Defrag Professional Setup Wizard

.
a Setup - Auslogics Disk Defrag Professional ==

If you bought the program on This will install Auslogics Disk Defrag Professional 4.0 on your
i N - i computer.

aCh dISk' “j‘sert tl_’]e dISk Into a Itis _rec_cmmended that you dose all other applications before

CD/DVD drive which will continuing.

launch the Setup Wizard. If ERck Xt kn con e Cancel o St ot
the program does not start
automatically, open My
Computer, select the CD/DVD

drive and double click on the
program file to launch it

manually.

2. Onthe Welcome screen, click ~ 4
Next.
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Read through the License Agreement on the screen that follows, select | Accept the Agreement

and click Next.

Choose the destination folder where the program files will be placed. By default, the installer
puts the program in C:\Program Files\Auslogics\Auslogics Disk Defrag Professional, but you can
click Browse and select a different destination, if you prefer. Click Next to continue.

Select the Start menu folder the program shortcuts will be placed in. By default, they are placed
in Auslogics\Disk Defrag Professional, but you can specify a different folder, if you prefer.

Click Next to continue.

If you would like to create a desktop icon for the program, you can do so by checking the box on
the next screen (it is checked by default). If you prefer not to install a desktop icon, uncheck the
box. This is the last option you can adjust in the Setup Wizard. Once you click Next on this screen,
the installation will begin. It will only take a few moments.

If you have an older version of Auslogics Disk Defrag Professional, the installer will uninstall it

automatically.

Once installation is complete,
a screen will be displayed to
confirm that Auslogics Disk
Defrag Professional was
successfully installed. You can
check a box to automatically
launch the program after
closing the Setup Wizard (it is
checked by default) or
uncheck it to later launch the
program manually.

To launch the program later,
click on the program icon on
your Desktop, if an icon was
installed. Alternatively, you
can go to the Start menu,

-
Q Setup - Auslogics Disk Defrag Professional = ——

auslogics Completing the Auslogics Disk
Defrag Professional Setup Wizard

Setup has finished installing Auslogics Disk Defrag Professional
on your computer. The application may be launched by
selecting the installed icons.

Click Finish to exit Setup.

Launch Auslogics Disk Defrag Professional

L 4

select All Programs > Auslogics > Auslogics Disk Defrag Pro to launch the program.

INSTALLING THE PROGRAM _



Registering the Program

1. Ifyouinstalled a trial version of the software, you have 30 days to use the program free of
charge. If you decide to keep it, you will need to purchase a license code and register the
program. This is very easy to do from the program interface by clicking on the Trial expires in ...
days link in the status bar at the bottom of the program window.

|
Trial expires in 13 days Priority: Balanced

2. Inthe window that pops up, click the Purchase Now button. This will take you to a secure
website where you can complete your purchase. You can select the program to be mailed to you
on a CD, or a download and a license code delivered electronically. If you choose the latter, the
license code should arrive in your email box within a few minutes after your payment is received.
The CD will usually arrive a few days after it is paid for.

3. Once you have a license code, you will need to activate it. To do so, you can again click on the
Trial expires in ... days line in the status bar at the bottom of the screen. Select | Already Have a
License Code in the window that appears and enter your license code on the following screen.

“
Auslogics Disk Defrag Professicnal M

\ ; ' Enter License Code

Already purchased? Please copy the license code from the order e-mail into
the box below:

License Code: JOCCOCK- 00000 X000 00000 00000 X000

Click here to purchase the program

Register ] [ Cancel

Note. When a license code is received via Email, it is best to copy it from there and paste it on the
registration screen, rather than try entering it manually symbol by symbol. This will prevent
any errors and make the registration a little easier.

REGISTERING THE PROGRAM u



Uninstalling the Program

1. To uninstall the program, open the Control Panel from the Windows Start Menu.

2. In Windows 7 or Vista double-click Programs and Features, or, if in category view, select
Programs > Uninstall a Program, then select Auslogics Disk Defrag Professional from the
programs list and click Uninstall.

3. In Windows XP you will see Add/Remove Programs category instead of Programs and Features in
the Control Panel - double-click on this category, select Auslogics Disk Defrag Professional from

the list and click Remove or Add/Remove, depending on what view you are using.

4. This will completely remove the program from your computer, including all associated files and
folders.

UNINSTALLING THE PROGRAM



Defrag Wizard

When you launch the program for the first time, Defrag Wizard is the tool you will first see. It is
intended to help you start using the program right away by creating simple defragmentation and
optimization tasks that fit your computer usage style and schedule. The Defrag Wizard window has
several tabs:

Auslogics Disk Defrag Professional u
7 Computer Type Computer Usagea [ Idle Time E ¢, Scheduling ﬂ
Home © Rarely Saturday, Evening 4 task(s)

1 Computer Type Under the Computer Type tab, you will need to specify what purpose you mostly
use your computer for - home, office, gaming or as a server. Select the appropriate
option and click Next.

This information will help the program tailor recommendations to your specific
needs. If you select one of the first three options, you will then proceed to the
Computer Usage tab. Choosing the last option will replace the next two tabs with
the Server Type tab, to which you will continue once you click Next.

2 Computer Usage Under this tab, specify how often you work with various types of documents or use
the Internet. Again, this is needed for tailoring recommendations to your specific
situation. Select the appropriate options and click Next.

3 Idle Time Under this tab, you will need to select the days of the week and time of day when
your computer is on, but is not used. This will allow the program to schedule
defragmentation and optimization of your drives for the times with the minimum
risk of conflicts with other applications and activity. Select the appropriate options
and click Next.

Server Type If you selected Server as the type of computer you have, this is the tab that you will
see instead of the two previously described tabs. You will need to specify whether
yours is a file, web, mail or database server. You can also check Other or Mixed, if
your server performs more than one of these functions. Once you choose the
appropriate option, click Next.

DEFRAG WIZARD



4 Scheduling This tab will provide a list of recommended tasks with scheduled times that the
Wizard puts together for you based on your answers to previous questions. Hold
your mouse pointer over a recommended task to see its detailed description.

You can uncheck the tasks that you do not wish to schedule, and keep only the tasks
that you would like to be performed.

Once you are done, click Schedule. This will close the Wizard, and the scheduled
tasks will run at the specified times. A list of these tasks will be available for viewing
and/or editing in the Scheduler tool described further in this document.

DEFRAG WIZARD



Interface

The following picture shows the main program window and its components. Clicking on the links
below the picture will take you to the section of this document where the component is described in
more detail.

o B
i Auslogics Disk Defrag Professional Elﬂlg

o—_ Action  View Settings Help

- r s .
@ Disks = & Reports  w 17 Scheduler ¥ r|'| Resource - o o

MName Size Free Space W55 55D Scheduled Offline

£ Local Disk (C:) 117.19 Gb 543960 & [x] V] o

—alLocal Disk (D:) 47897 Gb 12442Gb @ (%] (%] Q |
[ Analyze l [ Defrag |Vl | Pause | | Stop | (U] After completing: |Shut Down PC v|
g [T 1116 l | | | E
= ]

0_ General | Files (D:) | Statistics (D:)] (2] [ ) (] ) ) () )

o In this tab you can view the results of the last operation performed on the selected disk, the system state, brief statistics, get
advice on how to keep your system in perfect condition and get acquainted with defragmentation technologies.

Go to: Last Operation | System Health | System Statistics | Hints

.

O °

Last Operation Results (D:)  view detailed report

Start time: 1/12/2012 at 1:06:18 PM
Action: Analysis -
e— The program is registered Priority: Balanced Diskz 0 bytes/'s Processor: 3%
L. A

1 Main Menu

2 Main Pane

2 Status Bar
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Main Menu

There is a menu bar at the top of the program window. It consists of 4 tabs that contain several
subcategories each. Some of these subcategories change dynamically in the first two menu tabs,

depending on which main pane tab is activated.

g Auslogics Disk Defrag Professional

‘Action View Settings Help)

Action Tab

The Action tab allows you to quickly select an action to be performed. The one constant option under

this tab is Exit, which allows you to exit the program. The remaining categories are dynamic.

When the Disks tab is activated in the main pane, the
options under the Action tab are:

=  Analyze

= Launch defragmentation or optimization by selecting
a desired profile (all profiles marked as active will be
listed here)

=  Launch Defrag Wizard

= Advanced options where you can select to defrag
local drives, defrag a file or folder, check for errors
with or without fixing them.

System Report

Exit

Report.

When the Scheduler tab is activated in the main pane,
the Action tab shows options to schedule
Defragmentation by Time, Auto Defragmentation, or
Offline Defragmentation.

Analyze

Simple Defrag
Consclidate Free Space

Optimize by Prefetch Layout
Advanced
Defrag Wizard...

Exit

When the Reports tab is activated in the main pane, the
Action tab will provide an option to generate System

Schedule Time...
Schedule Auto...
Schedule Offline...

Exit

INTERFACE



When the Resource tab is activated in the main pane, the
Action tab allows you to easily access two built-in Windows
tools - Windows Reliability and Performance Monitor and
Power Option Manager in the Windows Control Panel.

Performance Monitor

Config Power 5cheme

Exit

View Tab

The View tab allows you to select what is viewed in the main window. In the constant section of this
tab, you can choose between Disks, Reports, Scheduler or Resource usage maps, which activate the
respective tabs in the main pane. Then, depending on which of these options is activated, some
dynamic selections become available.

Check All Ctrl+A
. . ) . Uncheck All Ctrl+Z

When the Disks tab is activated, the View menu
Invert Checkboxes Ctrl+1

additionally allows you to check and uncheck disks in the
list, invert checkboxes, check all local drives, and show or Check Local Disk Drives  Ctrl+L
hide speed zones on the cluster map.

Show Speed Map

Show Columns 4
When the Reports tab is activated in the main pane, the

View menu tab lets you specify which columns you want to
see in the report, to set the sort order, and to size all
columns to fit the text, if needed.

Sort by »
Size All Celumns to Fit

Disks

When the Scheduler tab is activated, the View menu has the same options as above (select columns
to view, sort order and fit to size), but with different subcategories that are now related to scheduled
tasks.

When the Resource tab is activated in the main pane, there are no additional options under the View
tab besides the constant ones specified earlier.
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Settings Tab

The Settings tab allows quick access to program settings,
cluster maps, defragmentation profiles, resource usage
profiles and priority settings. The options here are
constant and do not depend on which main pane tab is
activated.

Help Tab

Help

Company Web 5ite
Technical Support
Check for Updates

About

Program Settings...
Cluster Map...

Defragmentation Profiles...

Resources Profile...

Priority

The Help tab is where you can access the standard help
materials, company website, technical support, as well as
view details about the program version. These options are
constant for all main pane views.

INTERFACE



Main Pane

The main pane has its own menu that makes the program’s main functions visible at all times and
lets you quickly switch between them. It contains tabs for Disks, Reports, Scheduler and Resource
usage.

4 !
@ Disks h Reports - 17 Scheduler Resource A o
MName Size Free Space V55 55D Scheduled Offline
[C] £ Local Disk (C3) 117.19 Gb 5439Gb @ Q V] [x]
|[#] - Local Disk (D:) 478.97 Gb 12442Gb @ [~] [x] [x]
[ Analyze l [ Defrag |V] Pause Stop & [£] After completing: | Shut Down PC
1  Disks Tab

2  Reports Tab

3 Scheduler Tab

4 Resource Tab
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Disks Tab

When the Disks tab is activated, following is what the program window looks like. Clicking on the
links below the picture will take you to the section that describes the corresponding window
component in more detail.

Disks = & Reports ? Scheduler w 'm Resource - ” o H
MName

Size Free Space VS5 55D Scheduled Offline

£ Local Disk (C) 117.19 Gb 5439Gb @ Q ] [x]
—u Local Disk (D) 478.97 Gb 12442Gb @ ] %] ] |

[ Analyze ] [ Defrag |V] [ Pause ] [ Stop ] & After completing: | Shut Down PC Vl

—

O] P —.\ — —
]

General | Files (D) | Statistics (D:) | (2 [ [ () (6 (6 (]

o In this tab you can view the results of the last operation performed on the selected disk, the system state, brief statistics, get
advice on how to keep your system in perfect condition and get acquainted with defragmentation technologies.

Go to: Last Operation | Systemn Health | Systemn Statistics | Hints

o The disk is in excellent condition. I%II

Last Operation Results (D:)  view detailed report

Start time: 1/12/2012 at 1:06:18 PIM
i @ Action: Analysis -
1 Disks List
2 Cluster Map
3 Operation Results Summary Section
4  Defrag Controls




Disks List

In the list of disks you can see the current status of all disks installed on your PC. You can check one
or more disks to analyze, defragment or optimize:

@ Disks  w

MName Size Free Space W55 550 Scheduled  Offline  Status
&L Local Disk (C)  117.19 Gb 541266 @ > o & O Ready for operation
—a Local Disk (D:) 478.97 Gb 124.41 Gb [ % [ % [v] [ @ Defragmented.

The icons in the list give information about your disks:

Item Icon What it means

(V] Volume Shadow Copy Service is enabled for the disk.

Vss’
X ] Volume Shadow Copy Service is not enabled for the disk.
(v] The disk is Solid-State Drive.
ssp”
[ X ] The disk is not Solid-State Drive.
(V] One or several defragmentation tasks are scheduled for the disk.
Scheduled
[ X ] There are no scheduled tasks for the disk.
(V] Offline defragmentation is scheduled for the disk.
Offline
X ] Offline defragmentation is not scheduled for the disk.
(V] The disk is ready for any operation (analysis, defragmentation, etc.).
(> ] An operation (analysis, defragmentation, etc.) is underway.
(1] An operation (analysis, defragmentation, etc.) is paused.
Status
-] File fragmentation level is low or there is no fragmentation at all.

<& File fragmentation level is high and the disk needs to be defragmented.

0 Signifies serious problems or errors that require user’s immediate attention.
It is also used to warn that an operation was interrupted.

’ VSS, or Volume Shadow Copy Service, is a backup & restore function in Windows that makes copies of volumes (hard
disks, etc.)

SSD, or Solid State Drive, is a data storage device that contains no moving parts and uses solid state memory for data
storage.
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Cluster Map

The Disks tab is also where you can see a cluster map that allows you to view brief information on
each cluster block when you hold your mouse pointer over it.

Fragmented

There are 47 files (8 fragmented in this block).
Click to view files.

You can select individual blocks and view a list of files in the block along with their status (whether
they are fragmented or not, unmovable, their level of fragmentation, etc.).When an operation is
underway, the map will show its progress.

Colors of blocks in the cluster map indicate the following:

Color

What it means

[

There are no files in the block (free space)

The block is occupied with files (fragmentation is not defined - disk analysis is required)

The block contains non-fragmented files

The block is occupied with MFT files

The block contains fragmented files

The block is occupied with unmovable (locked) files

The block contains files that were added to the exclusion list

=

The block contains files that are currently being processed by the program

MFT, or Master File Table, is a unique system file that essentially acts as a database containing metadata about every file,
directory or metafile on an NTFS volume. It includes filenames, locations, size, and permissions.

You can customize the look of your cluster map by applying different color themes. For doing this,
please see the Cluster Map Appearance chapter.
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Operation Results Summary Section

In the bottom part of the window there is the Operation Results Summary section - a dynamic pane
where you can view detailed information about the disk condition, operations that have been
performed on it, system health and statistics, along with helpful hints. This pane has its own menu at
the top, which lets you switch between different views.

General Tab

General | Files (C:) | Statistics (C:)

o In this tab you can view the results of the last operation performed on the selecte
in perfect condition and get acquainted with defragmentation technologies.

Go to: Last Operation | Systern Health | Systern Statistics | Hints

The General tab shows a brief overview of the disk’s state and last operation results, along with
system health and system statistics. Quick links above the text allow you to skip to the part of the
page you want to review.

Here you will see the type of last operation performed, its start time and whether it was completed
successfully. This information is followed by brief advice on what type of operation is recommended
to perform on this disk, if any.

Further down, you will see detailed performance charts that visually demonstrate any improvements
achieved during the last operation. You see the before and after numbers for performance,
fragmentation, free space fragmentation, the size of the largest free space block, as well as number
of files analyzed and number of fragmented files before and after the operation.

e Performance: before -— TLT0% . v

after — 1 S

Fragmentation:  before (i o/ 4 Cv

after 0.00%

Note. These details are only available after operations that gather such information and perform
the actions needed to get these results.
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To the right, you see graphic charts for performance and fragmentation that display the status of
these two parameters over time.

Each date is marked with a colored dot on the Performance Days
chart to show whether there were operations 100.0% s * s .
performed on that date. Red stands for no I A A S TN
operations performed, blue - only analysis was I
performed, green - defragmentation or T75%

12/26/2011

optimization tasks were performed on the date.

Holding your mouse pointer over a dot will bring up a note that will show the number of reports
available for the date, as well as minimum, maximum and average performance or fragmentation for
the date.

If there are reports available for a date, clicking on the dot will take you to the Reports tab where
you can view those reports.

The System Health section has graphs that provide info on the overall performance of all drives in
the system, as well as total fragmentation for all drives. The graphs are similar to what you see in the
previous section - with colored dots that you can click on to view available reports.

The System Statistics section provides a table of statistical data for all operations performed since
program installation, which includes total numbers of defragmented and optimized files and folders,
as well as numbers broken up by different operation types. Clicking the View detailed statistics link
next to the section header (or further up in the operation results summary) will take you to the
Statistics tab, where you will find more detailed information.

System Statistics  view detailed statistics

@ after installing the program: defragmented: optimized:
total: 562 file(s) B folder(s) 2305 file(s) 63 folder(s)
including: autodefragment: B0 files) 0 folder(s) 0 file(s) 0 folder(s)
scheduled defrag: 80 file(s) 0 folder(s) 0 file(s) 0 folder(s)
offline defrag: 3 file(s) 0 folder(s) 0 file(s) 0 folder(s)

The last section under the General tab is Hints, which provides general tips and advice on getting the
best results from using the program.
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Files Tab

General

Files (D0} | Statistics (D:)

In this tab you can view a list of fragmented files and folders for the selected dis!

Go to: Exclusions List | List of all files in the block | List of clusters in a block

-

Path File Marm

(] D SMF
DA\ SEstend! ¢

The Files tab shows a list of fragmented files on the selected disk. This is where you can select files
that you want to defragment individually. There are quick links above the files list that let you access
the list of exclusions (in case you want to add any files to that list), as well as switch to Selected Files
and Selected Clusters views.

The file list itself has the following columns:

= The Path column, which includes checkboxes that allow you to check individual files to be
defragmented; file type icons that mark fragmented, unmovable, MFT or excluded files; and the
path to the file’s location on the disk.

= The File Name column lists the file name along with a descriptive icon that shows file format or
marks folders.

= The Status column describes whether an item is a directory or a file, and marks unmovable and
excluded files.

=  The remaining columns - Size, Fragments and Relative Fragmentation - specify the item’s size,
number of fragments into which it is broken up, and the item’s relative fragmentation.

When lists are long, you can filter them to show only files with specified parameters. To do that,
specify file name, size, and/or number of fragments in the search boxes below the list (or specify
block size under the Selected Clusters list view), and the program will automatically filter the lists as
you enter the search criteria. To clear the search criteria, click on the * icon located to the left of the
search boxes.

-

]

®  enterfile name to search  less than1 Mb w  lessthan 5 fragments

The program is registered Priority: Balanced Disk: 0 bytes/s

INTERFACE



If you click on a block in the cluster map, two additional tabs will appear - Selected Files and Selected
Clusters, allowing you to view a list of files and clusters contained in the selected block.

The Selected Files list has the same columns as the files list described earlier. Right above the list you
will see a note telling you which clusters are located in the selected block (cluster numbers). You can

sort the list the same way as under the Files tab.

General | Files (C:) | Selected Files (C:) X | Selected Clusters (C:) ¥ | Statistics (C:) |

o In this tab you can view a list of all files and folders in the selected block on the ¢

Clusters selected from 10,043,171 to 10,117,017

Path File Marr

CAWWindows\Microsoft. MET assembh\GAC_MSIL System Windows. Forms'...

The Selected Clusters tab lets you explore the specified block from a different perspective - the table
lists fragmented files in the order of clusters they occupy. The file list itself has the following
columns:

= The Status column shows whether an item is a file or a folder and marks unmovable files.

= The Start column specifies the number of the first cluster in the space occupied by the item.

=  The Count column shows the number of clusters occupied by the item.

= The Size column shows the size of the selected block.

= The Path and File Name columns list the file path and name respectively.

You can filter the clusters list by the file name or block size using the tools below the list.
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Statistics Tab

Statistics (D:)

In this tab you can view the statistics and detailed information on the selected di:

Go to: Disk Information | Performance | Fragmentation | Free Space Fragmenta

- Performance is determined by several parameters and Pe
shows the general condition of the disk,

The Statistics tab lets you view detailed statistics on the selected disk. To simplify access to the
desired section of disk statistics, there are quick links at the top for Disk Information, Performance,
Fragmentation, Free Space Fragmentation and Fragmented Files.

Disk Information includes disk specs, which are listed next to a disk chart showing the amount of
used and free space. Holding your mouse pointer over the green or blue area on the disk chart will
tell you the exact size of the free or used space on the disk. Disk specs can be saved in a text file or
copied to buffer by clicking on the buttons below the disk info.

Below the Disk Information section, you will see detailed fragmentation and performance statistics
presented in the form of charts and graphs. Each statistics group starts with a brief overview of what
the statistics listed there is for, and shows last, maximum, average and minimum values for the
parameter. Furthermore, these values are marked on a graphical chart to the right using color-coded
dots. Red means no operations performed, blue means only analysis was performed in the specified
time period, and green means there was defragmentation or optimization performed.

You can follow the parameter state by hours, days or weeks by selecting the view mode in the top
right corner of the chart. You can also scroll through the chart to go forward or back in time by
clicking on the arrows in the bottom left and right corners.

Fragmentation Hours Weeks
25%
L]
-
- L L L L] L] L] - -
0.0%

© 12/31/2011 1/20/2012 &

Clicking on a dot on one of the charts will take you to the Reports tab and let you view all reports
available for the date, if any.
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Defrag Controls

| ) © E
: I Rezource -

1 -
@ Disks w u:}\‘ Reports  w 17 Scheduler

MName Size Free Space VS5 550 Scheduled Offline
£, Local Disk (C3) 11718 Gb 54.30 Gb
Local Disk (Dx) 47897 Gb 124,42 Gb

When the Disks tab is selected, the additional controls displayed at the top include the following
quick access buttons:

Button Purpose

1 Launch Defrag Wizard
2 o Configure Defrag Profiles
3 Configure Resource Profiles
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Reports Tab

Under the Reports tab, you can see a list of available reports, with report details displayed in the
bottom part of the window, when a report is selected. Following is what the program window looks
like when the Reports tab is activated:

Create Time

System Report | Report storage options

E L] I
@ Disks = m Reports - 17 Scheduler - ﬁ Resource - l x I

o

Dizk Action Work Time =
1/12/2012 1:06:15 PM Local Disk (C:) @ Disk Analysis 00:00:00
1/12/201212:37:21 PM Local Disk (C:) £ Sirnple Defragmentation 00:00:56
1/12/201212:33:32 PM C &) Sirnple Defragmentation (Offline ... 00:00:52 H
1/10/2012 8:29:43 PM Local Disk (D7) @ Disk Analysis 00:00-00
1/10/2012 8:29:43 PM Local Disk (C:) @ Disk Analysis 00:00:00 -

4

m | b

o

In this tab you can view information on the report selected from the list. For each report,
you can view rmore detailed information, print it and save it in a format convenient for you.

View | Print | Save As

Operation Results (C:)

'u)\

RENE

On this page you can view all reports on all of the operations and create a systern report for all disks in the systern. Reports can be
viewed, printed and stored in a format convenient for you, Storage life of reports is determined in the program settings.

"« January, 2012 » |

S M T WT F S
1 2 3 4 5 6 7

9 @11 @) 13 14
16 17 18@@11

8
15
22 23 24 25 26 27 28
29 30 31

J Today
@ Start time: 1/12/2012 at 12:36:25 PM ) Report(s) available for this date
Action: Simple Defrag =
Result: Defragmented successfully
@ Performance: before 98.04% Y
after — L, — -
Section Purpose

1 Reports List

Shows you the list of reports for all operations performed by the program.

2 Reports Details

Shows you detailed information on the report selected from the list.

3 Calendar

Allows you to view reports for certain dates. You can select a date on the

calendar and reports available for that date will be displayed.

Reports Controls

A set of buttons for managing reports (deleting, printing, saving, etc.)
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Reports Controls

- IE mnnn
|ﬁ| Disks LL;A_.% Reports - 17 Scheduler
L= ] 15

p— - 33852

o On this page you can view all reports on all of the operations and create a systemn report for all disks in the system. Reports can be
viewed, printed and stored in a format convenient for you. Storage life of reports is determined in the program settings.

System Report | Report storage options

When the Reports tab is selected, the additional controls displayed at the top include:

Button Purpose
1 b4 Delete report.
2 o} Open report for viewing.
3 - Print report.
4 | Save report in a format of choice.

Generate system report.

For more information on viewing, saving and printing program reports, see the Program Reports

chapter.
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Scheduler Tab

This is what the program window looks like when the Scheduler tab is activated:

E e
@ Disks m Reports = 17 Scheduler ﬁ Resource -

On this page you can manage the list of scheduled tasks and view the results of the last run.

Schedule: Defragmentation by Time | Auto-Defragmentation | Offline Defragmentation

¥

o

—
[¥=|

=)o ])(a)=](x

Task Run Conditions Enabled State

() Scheduled Defragmentation (C:) Every Sunday at11:00:00 PM ' active & wait

@ Offline Defragmentation (C:) Once during the next boot inactive € disabled
@ Auto Defragmentation (D:) When idle for 30 minute(s), ... v active & wait

<]

1 |

o

from the list.

Goto: Local Disk (C:)

In this tab you can see the results of the last operation performed within the task selected

Operation Results (C:)

| »

"« January,2012  » |

S M T WT F S

1 2 3 4 5 6 7
8 9 10 11@13 14
15 16 17 18 19 @@

LEHEODD®
@eeEd

) Today
@ Start time: 1/12/2012 at 12:36:25 PM O) Task(s) executed on this date
Action: Simple Defrag = O Task(s) scheduled
Result: Defragmented successfully
@ Performance: before ’ 08.04% i v
after — L S— -
Section Purpose

List of Scheduled
Tasks

Shows you all defragmentation tasks that are scheduled on your PC. Also

allows enabling/disabling these tasks by clicking on the » or

icons.

Last Operation
Results Summary

Shows the report for the last operation performed within the task selected

from the list.

3 Calendar

Allows you to view tasks scheduled for certain dates. You can select a date
on the calendar and the tasks scheduled for the date will be displayed.

Scheduler
Controls

A set of buttons for managing scheduled tasks.

INTERFACE



Scheduler Controls

iF R
@ Disks H:Q\‘ Reports  w 17 Scheduler = m Resource - @|8I[FE]| x

On this page you can manage the list of scheduled tasks and view the results of the last run,

Schedule: Defragmentation by Time | Auto-Defragmentation | Offline Defragmentation

When the Scheduler tab is selected, the additional controls at the top include:

Button Purpose
1 Launch Defrag Wizard
2 [+ ] Run selected task.
3 g Copy selected task.
4 = Edit selected task.
5 x Delete selected task.

For more information on how to schedule and manage defragmentation tasks, see the Scheduling

Tasks chapter.
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Resource Tab

The Resource tab lets you view current graphs of general system resource usage and the amount of
resources used by the program:

T -
@ Disks = “:}\ Reports hd 17 Scheduler - ﬁ Resource - ] ) Resource Profile

@

the graphics of the current load on system resources, the load produced by the defragmentation process

In this tab you can see
and the current restriction on the use of resources in accordance with the selected profile.

Config Profile | Performance Monitor | Config Power Scheme

»

Processor usage AMD Phenom(tm) IT X4 940 Processor b
100% & Total usage: 2%
B Defragmentation process: 0%
0% L:;f\:;__i__,:-;&;hﬁﬂw-»ﬁu-‘ A ,Aq\_,_____,f B Active constraint auto
Disk usage (MB/s) The amount of disk space: 596.16 Gb
60.0 & Total usage: 6.21 kb/s
B Defragmentation process:  1.16 kb/s B
0 B Active constraint: auto
Memory usage (Gb) The amount of memory: 4.00 Gb
4.0 & Total usage: 1.33 Gb
B Defragmentation process: 41.79 Mb
0
Section Purpose

Resource Usage

Shows you the current load on your CPU, Disks and Memory (RAM), as well

1
Graphics as power source and battery state (for systems with a battery).

5 Resource Allows you to access Resource Profile settings for managing the load on
Control your system resources produced by the program.

For more information on

how to manage the load on your PC's system resources produced by the

defragmentation process, see the Configuring Resource Profiles chapter.
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Status Bar

The program window has a status bar at the very bottom. If you are using a trial version of the
software, this is where you see the "Trial expires in .. days" notification. You can click on this notice
to purchase and/or register the program (see the Registering the Program chapter).

{ Trial expires in 13 days | Priority: Balanced  Disk: 116 kb/s  Processor: 4% | No actions

The bar also displays various status specs depending on which main pane tab is activated. You will
see such info as current priority settings, disk and CPU usage (when the Disks tab is selected), and
number of reports or tasks in the list (when Reports or Scheduler tabs are selected).

When an operation is underway, you will see the operation name and its progress info here, or see
"No Actions" if there are no operations being performed.
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Basic Usage

To give you a general idea of what each type of operation does to improve system performance, here

is a brief overview of each operation’s functions:

Operation Type 0 ] _5
%) E E '.\'-5. g c
2 =8 5§ | g% | 24
g 2 ea E =2 | 8¢
) < ~ x v © v o g >
Action = Q o 9 & = s =
a S S & a & S o0&
Analyzes disks for fragmentation o - - . = -
and other specs w w w w w
Checks disks for errors L X Q @ [ X ] [ X ] W
Corrects errors found on disks [ ] [ X ] @ [ X ] [ X ] | X ]
Defragments files and folders [ ] [ X ] [ X ] (V] v V]
Defragments free space on disks [ X [ X ] [ X ] L X (V] | X
Optimizes file placement on disks L X} X} | X L X L X} (V]

While a wide array of customization options is available for those who require them, the program
comes with default settings that allow you to analyze, defragment and optimize your disks with just a

click of a button.



Analyzing Disks

Before you launch defragmentation or optimization, disk analysis is recommended. It reads disk
information and shows you a true picture of the disk’s condition, including file and free space
fragmentation, system performance, and recommended actions.

To perform disk analysis, follow these steps:

1. Select the Disks tab in the main pane menu.

2. Inthe list of disks, select the disk you would like to analyze by checking the box next to its name
and click the Analyze button below the disks list. This will launch disk analysis.

r ]
@ Disks  w m Reports 17 Scheduler = : I Resourc:
Mame Size Free Space W55 SsD Scheduled
[[] 24 Floppy Disk Drive (4 [} o a
|[¥1 & Local Disk (C:) 11719 Gb 5338 Gh @ [x] ]
aLocal Disk (D) 47897 Gb 124426 & o o
’ Analyze ] ’ Defrag |"l Pause Stop

While the operation is underway, its current status is shown in the main pane, as well as in the
disks list next to the name of the disk being analyzed.

3. Upon completion, analysis results will be displayed in the main pane. A brief description of the
result is also shown in the list of disks.

You can switch to the Files tab to view a list of fragmented files and, if desired, select the files
you want to defragment individually.

Files (C:) | Statistics (C:)

General

In this tab you can view a list of fragmented files and folders for the selected disk =

Go to: Exclusions List | List of all files in the block | List of clusters in a block

Path File Name
[ W Ch\Users\AdmintAppDatatLocal\Google\ChrometUser Datat\Default' | Curre

Mot lear Mlatat Mlafar |+



When you select a file from the list, the location of its fragments will be highlighted on the
cluster map.

Clicking on a block on the cluster map will produce two additional tabs - Selected Files and
Selected Clusters - which will let you view lists of files and clusters in the block that you selected
on the map. For more details, see the Operation Results Summary chapter.

You can also view a detailed report, print it or save it in a choice of formats - see the Program
Reports chapter of this document for instructions.

Checking Disks for Errors

Before you launch defragmentation, it is a good idea to check your disks for errors. Whenever a disk
has errors, there is a risk that data may get corrupted during defragmentation. By checking for errors
and fixing any errors that are found, you ensure that no data will get lost or corrupted when you
launch defragmentation.

To check a disk for errors, follow these steps:
1. Select the Disks tab in the main pane menu.

2. Inthe list of disks, select the disk you would like to scan for errors by checking the box next to its
name.

3. Select the Action tab in the main menu and go to Advanced > Check for Errors. Alternatively, you
can access the same functions by clicking on the arrow in the Defrag button and selecting
Advanced > Check for Errors from the drop-down menu:

[ Defrag |"]

Simple Defrag
Consolidate Free Space
Optimize by Prefetch Layout

Advanced » Defrag Local Drives
Defrag Wizard... Defrag a File...
Statistics (C:) | Defrag a Folder...

b you can view the results of the last operati Check for Errors

Check & Correct Errors

This will launch the error scan. While the operation is underway, its current status is shown in the
main pane, as well as in the disks list next to the name of the disk being scanned.



4. Upon completion, error check results will be displayed in the main pane. The disks list will have
brief results specified next to the disk name, and you can view, print or save a detailed operation
report — see the Program Reports chapter for instructions.

Fixing Errors

If errors were found during the check, you should try fixing them before you proceed to defragment
the disk. To do this, follow these steps:

1. Select the Disks tab in the main pane menu.
2. Inthe list of disks, select the disk that has errors by checking the box next to its name.
3. Select the Action tab in the main menu and go to Advanced > Check & Correct Errors.

Alternatively, you can access the same functions by clicking on the arrow in the Defrag button
and selecting Advanced > Check & Correct Errors from the drop-down menu.

[ Defrag |V]

Simple Defrag
Consolidate Free Space

Optimize by Prefetch Layout

Advanced » Defrag Local Drives
Defrag Wizard... Defrag a File...
Statistics () | Defrag a Folder...

b you can view the results of the last operati Check for Errors

Check & Correct Errors

The program will attempt to fix the errors found during the scan. While the operation is
underway, its current status is shown in the main pane, as well as in the disks list next to the
name of the disk on which errors are being corrected.

4. Upon completion, error correction results will be displayed in the main pane with a brief
description shown in the list of disks. See the Program Reports chapter for instructions on
viewing, printing and saving detailed operation reports.




Defragmenting

When you are ready to start defragmenting, follow these steps:
1. Select the Disks tab in the main pane menu.

2. Inthe list of disks, select the disk you would like to defragment by checking the box next to its
name and click the Defrag button below the disks list.

4 I
@ Disks  w h; Reports - 17 Scheduler

[

-f_rl Resource

Mame Size Free Space WSS Ss5D Scheduled
[C] &= Floppy Disk Drive (&) ] ] Q
|[¥] &%, Local Disk (C:) 11719 Gb 5338Gb @ [%] (]
= Lecal Disk (D3 478.97 Gb 12442Gb @ [x] [x]
’ Analyze ] ’ Defrag |"l Pause Stop

3. This will launch the default Simple Defragmentation profile. While the operation is underway, its
current status is shown in the main pane, as well as in the disks list next to the name of the disk
being defragmented.

4. Upon completion, defragmentation results will be displayed in the main pane with a brief
description of the result shown in the list of disks. To view, print or save a detailed report, see
the Program Reports chapter for instructions.

Consolidating Free Space

Since fragmentation of free disk space causes file fragmentation and affects file write speed, it is
important to consolidate free space to keep your system in a good operating condition. To perform
free space consolidation, follow these steps:

1. Select the Disks tab in the main pane menu.

2. Inthe list of disks, select the disk on which you would like to perform free space consolidation by
checking the box next to its name.

3. Click on the arrow on the Defrag button below the disks list. This will open a drop-down menu
showing all active defragmentation and optimization profiles.



4. Select Consolidate Free Space from the drop down menu.

[ Defrag L‘d
Simple Defrag

Consolidate Free Space

Optimize by Prefetch Layout
Advanced ¥

Defrag Wizard...
Statistics {C:}|

y you can view the results of the last operation performed on the selected dizk, the =

This will launch the default free space consolidation profile. While the operation is underway, its
current status is shown in the main pane, as well as in the disks list next to the name of the disk
being defragmented.

5. Upon completion, consolidation results will be displayed in the main pane with a brief
description of the result shown in the list of disks. See the Program Reports chapter of this
document for instructions on how to view, print or save a detailed operation report.

Optimizing
The default optimization option that is preset as active when the program is installed is Optimization
by Prefetch Layout. This operation optimizes file placement on disks based on data supplied by the

Prefetch* system module. Its main effect is faster system loading and application launching. To
perform optimization by Prefetch layout, follow these steps:

1. Select the Disks tab in the main pane menu.

2. Inthe list of disks, select the disk you would like to optimize by checking the box next to its
name.

3. Click on the arrow on the Defrag button below the disks list. This will open a drop-down menu
showing all active defragmentation and optimization profiles.

" The Prefetch module is used in Windows to gather and store records of all events and processes that occur with
application and system loading, with the purpose of using this info for speeding up these processes in the future.



4. Select Optimize by Prefetch Layout from the drop down menu.

[ Defrag L‘d

Simple Defrag

Consolidate Free Space

Optimize by Prefetch Layout

Advanced 4

Defrag Wizard...
Statistics {C:}|

3 you can view the results of the last operation performed on the selected disk, the s

This will launch optimization. While the operation is underway, its current status is shown in the
main pane, as well as in the disks list next to the name of the disk being optimized.

5. Upon completion, optimization results will be displayed in the main pane with a brief description
shown in the list of disks. See the Program Reports chapter for instructions on viewing, printing
and saving detailed operation reports.

Note. For three additional optimization types (optimization by last file access time, change time
and by disk zone), see the Configuring Defragmentation Profiles chapter of this document.




Configuring Defrag Profiles

When you first install the program, there will be several preset defragmentation profiles with default
pre-configured options, which allow you to start defragmenting and optimizing your disks without
changing any settings. To view/manage defragmentation profiles, go to Settings > Defragmentation
Profiles from the main menu. The following window will appear:

@

& Ausledics Disk Defrag Professional: Defrag Profile l X J
Bk New ” B Copy ” W/ Default ” Disable ” X Delete ” 7 Help
Show Marne fil d
T 4 Profile name an e Simple Defrag, Simple Defra
+/ default Simple Defrag P . S .
v/ active Consolidate Free Space
inactive  Optimize by Access Time Unique profile name: Simple Defrag
inactive  Optimize by Change Time
inactive  Optimize by Disk Zone
v/ active Optimize by Prefetch Layout
Operation type: Simple Defrag - E
¥ Prevent Fragmentation Mot defined
¥ Compatible mode V55 mode, 55D mode
¥ Advanced actions Mot defined
oK Cancel

Section Purpose

Allows enabling/disabling profiles, as well as creating new profiles or

1 List of Profiles . L
deleting existing.

2 Action Buttons Allow managing the list of defrag profiles.

3 Settings Tabs Allow configuring each profile from the list.

CONFIGURING DEFRAG PROFILES



Preset defragmentation profiles include:

= Simple Defrag (set as the default profile) = Optimize by Change Time
= Consolidate Free Space =  Optimize by Disk Zone
= Optimize by Access Time =  Optimize by Prefetch Layout

You can select one or several of these profiles to be used as templates for your own customized
profiles, or create your own profiles from scratch.

Profiles marked as active are displayed in the drop-down menu of the Defrag button, as well as
under the Action tab in the main menu, which allows you to quickly launch defragmentation or
optimization with the settings you pre-configure for these profiles.

To configure defragmentation profiles, follow these steps:

1. Go to Settings > Defragmentation Profiles from the main menu.
Alternatively, when the Disks tab is activated in the main pane, you can access these functions by

mi
clicking on the ™ Defrag Profiles button in the main pane menu.

2. Inthe window that appears, choose the profile you would like to customize from the list on the
left, or click the New button at the top to create a new profile.

-
a Auslogics Disk Defrag Professicnal: Defrag Profile

B New 5 Copy ' Default Disable X Delet

Show Mame

w" default  Simple Defrag
W' active Consolidate Free Space

4 Profile name and type

inactive  Optimize by Access Time Unique profile name:
inactive  Optimize by Change Time .
It is recommended to select

name. This will help you recc
W' active Optimize by Prefetch Layout arofile list management

inactive  Optimize by Disk Zone

3. Inthe right pane, select a meaningful name for your profile that will help you recognize it in the
future.

4. Select the type of operation to be performed under this profile ‘SimEl.e Defrag |
from the drop-down menu. When you select an item from the Simple Defrag

drop-down list, a brief description of what the operation does é%

will appear right below it. Optimize by Change Time
Optimize by Disk Zone
Optimize by Prefetch Layout

5. Depending on what type of operation you select, a number of
additional customization menus are displayed further down.

CONFIGURING DEFRAG PROFILES



When you are done customizing these settings, you can set the profile status by clicking the
corresponding button at the top - you can choose Default (only one profile can have this status,
it will be launched by default when clicking the Defrag button), or Enable/Disable to make the

profile active or inactive (active profiles are displayed in the drop-down menu of the Defrag
button).

g Auslogics Disk Defrag Professional: Defrag Profile

B Mew 5 Copy W' Default Disable X Delet

Show MName

CONFIGURING DEFRAG PROFILES



Configuring a Simple Defrag Profile

When you select Simple Defrag as the type of operation for a profile, the additional menus will let
you configure fragmentation prevention algorithms, VSS and SSD compatibility modes, and additional
actions to be performed prior to defragmentation:

Operation type: Simple Defrag

Simple Defragmentation only defragments files without optimizing their placement on the
It is the fastest type of defragmentation.

» Prevent Fragmentation Mot
¥ Compatible mode WSS mode, S
» Advanced actions Mot

Prevent Fragmentation

To prevent fragmentation, you can leave some space after certain files, which will allow future
writing of data right next to the file and help keep file fragments together. You may want to do this
for files that constantly get data added to them (such as logs, database files, mail client files that are
used to store received messages, etc.).

To specify files after which you would like the program to leave some free space for writing data,
follow these steps:

1. Select the Prevent Fragmentation menu and list the file names separated with a comma in the
Files to be processed box.

2. Specify the amount of free space to be left after each file either as an exact number of bytes, kB
or MB, or as a percentage of the file’s size.

3. If any of the specified files get rarely modified, you can configure the program not to leave space
next to those files to prevent wasting disk space.

4. To configure the program to skip files that haven’t been modified in a certain number of days
prior to operation, check the appropriate box and set the number of days in the scroll box.
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Compatible Mode

When you have SSD” or VSS “-enabled drives, special care is required for defragmenting or optimizing
such drives. Regular defragmentation algorithms may cause the VSS storage area to grow excessively,
which in turn may lead to overwriting previous VSS snapshots. With SSD drives, too much writing to
them may have a negative effect on the disk’s operating life, so reducing the number of write
operations during defragmentation is preferable. The program is equipped with special tools to
prevent these negative effects from occurring.

To configure compatibility modes for these types of drives, follow these steps:
1. Go to the Compatible mode menu.

2. If you have a VSS-enabled drive and prefer not to defragment it, check the first box to skip VSS-
enabled drives. If you'd like to defragment a VSS-enabled drive, but want the program to utilize
special algorithms designed for such drives, check the Use VSS compatible mode box.

3. If you have an SSD drive and would like the program to utilize special algorithms designed for
such drives, check the Use SSD compatible mode box.

Advanced Actions

Under the Advanced actions menu, you can configure the program to perform additional tasks prior
to defragmentation, which will make the defrag process more efficient.

If a disk has errors, it is advisable to find and fix them before proceeding with defragmentation.
Otherwise, data corruption and/or loss may occur.

= To have the program check disks for errors before starting defragmentation, select Advanced
actions menu and check the box next to Scan disks for errors.

The user’s and Windows’ temporary folders usually accumulate files that are not needed and can be
safely deleted. Defragmenting these files would be a waste of time and space, so it is a good idea to
have such files deleted before starting defragmentation.

= To set the program to delete temporary files prior to defragmentation, check the box next to
Delete temporary files before defragmenting.

' SSD, or Solid State Drive, is a data storage device that contains no moving parts and uses solid state memory for data
storage.

VSS, or Volume Shadow Copy Service, is a backup & restore function in Windows that makes copies of volumes (hard
disks, etc.)
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Configuring a Consolidate Free Space Profile

When you choose Consolidate Free Space as the type of operation for a defrag profile, the additional
menu options you will see below will be Consolidation, Compatible mode and Advanced actions:

Operation type: Consclidate Free Space

Consolidate Free Space combines all free space blocks on a disk into one big block. It does
defragment files,

»  Consolidation Disable fragm
» Compatible mode

» Advanced actions Mot

Consolidation
Under the Consolidation menu, you can set the program not to defragment files while consolidating

free space. This will make consolidation go faster, but will leave files on your disk fragmented.

=  For faster free space consolidation, click on the Consolidation menu and check the box next to
Disable file defragmentation.

Compatible Mode

When you have VSS-enabled drives (Volume Shadow Copy Service), special care is required for
consolidating free space on such drives. Regular consolidation algorithm may cause the VSS storage
area to grow excessively, which in turn may lead to overwriting previous VSS snapshots. The program
is equipped with a special algorithm to prevent this negative effect from occurring.

To configure VSS -compatible mode, follow these steps:

1. Go to the Compatible mode menu.

2. If you prefer not to consolidate free space on your VSS-enabled drive, check the Skip VSS
enabled volumes box.

If you’d like to consolidate free space on your VSS-enabled drive, but want the program to utilize
special algorithm designed for such drives, check the Use VSS compatible mode box.
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Advanced Actions

Under the Advanced actions menu, you can configure the program to perform additional tasks prior
to launching free space consolidation, which will make the operation more efficient.

If a disk has errors, it is advisable to find and fix them before proceeding with consolidation to
prevent data corruption and/or loss.

= To have the program check disks for errors before starting the operation, select Advanced
actions and check the box next to Scan disks for errors.

The user’s and Windows’ temporary folders usually accumulate files that are not needed and can be
safely deleted. Such files take up the space that could otherwise be used during free space

consolidation, so it is a good idea to have such files deleted before starting the operation.

= To set the program to delete temporary files prior to consolidation, check the box next to Delete
temporary files before defragmenting.
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Configuring an Optimize by Access Time/Change Time Profile

Hard Disk tracks are subdivided into zones according to their distance from the disk center, with the
farthest from the center providing the fastest data access speed.

For defragmentation purposes, the disk is subdivided into 3 zones — Fast Zone (beginning of the disk),
Slow Zone (back end of the disk), and Normal Zone (in-between the other two zones). Placing
frequently accessed files in the fast zone helps promote system speed and reduce disk wear. As for
files that are frequently modified (especially when data is added), placing them in the slow zone
helps reduce disk fragmentation.

You can optimize file placement on disks by last access time (for faster access to frequently used
files), or last change time (to reduce fragmentation of frequently modified files). Here is a brief
overview of each method’s advantages:

Optimization by Last Access Time Optimization by Last Change Time

= Optimizes system disk operating speed and

= Optimizes read speed for faster access to .
reduces fragmentation of frequently

frequently used files

modified files

Frequently accessed files are placed in the
Fast Zone

Rarely changed files are placed in the Fast
Zone (most system files)

Rarely accessed files are placed in the Slow
Zone

Frequently changed files are placed in the
Slow Zone

Works best for disks that are used for storing
data (such as photos, music, video files, etc.),
or for disks that don’t have much else on

Works best when there is one hard drive in
the system that has system files and all

other data on it.
them besides system files.

To configure one of these two types of optimization, select Optimize by Access Time or Optimize by
Change Time as the type of operation for a defrag profile. The additional menu options that will
appear below will be Disk Zones, Disk Zone Parameters, Prevent Fragmentation, Compatible Mode
and Advanced Actions:
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Operation type: [ Optimize by Access Time

Optimize by Access Time defragments files and optimizes placement of files on a disk
according to the time of last access, It allows faster access to files.

¥ Disk zones Fast zone: no later than 30 days ago, Slow zone: later than 60
» Disk zone parameters Dis
¥ Prevent Fragmentation Mot

» Compatible mode

¥ Advanced actions Mot

Disk Zones

To specify what files are placed in the fast or slow zone, follow these steps:
1. Select the Disk Zones menu.

2. Select what files are placed in the fast zone by marking how long ago the file has to have been
last accessed or changed to be placed here.

3. Select what files are placed in the slow zone by marking how long ago the file has to have been
last accessed or changed to be placed here.

Any file that does not fit the specified criteria will be placed in the normal access zone.

Disk Zone Parameters

Although it may increase defragmentation time, you can enable file sorting within each zone to
achieve more thorough optimization. To do that, follow these steps:

1. Select the Disk zone parameters menu.

2. Check the Enable file sorting within a zone box to set ascending sort order for optimization by
last access time, or descending sort order for optimization by last change time.
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Prevent Fragmentation

To prevent fragmentation, you can leave some space after certain files, which will allow future
writing of data right next to the file and help keep file fragments together. You may want to do this
for files that constantly get data added to them (such as logs, database files, mail client files that are
used to store received messages, etc.).

To specify files after which you would like the program to leave some free space for writing data,
follow these steps:

1. Select the Prevent Fragmentation menu and list the file names separated with a comma in the
Files to be processed box.

2. Specify the amount of free space to be left after each file either as an exact number of bytes, kB
or MB, or as a percentage of the file’s size.

3. Ifany of the specified files get rarely modified, you can configure the program not to leave space
next to those files to prevent wasting disk space.

4. To configure the program to skip files that haven’t been modified in a certain number of days
prior to operation, check the appropriate box and set the number of days in the scroll box.

Compatible Mode

When you have VSS-enabled drives (Volume Shadow Copy Service), special care is required for
optimizing such drives. Regular optimization may cause the VSS storage area to grow excessively,
which in turn may lead to overwriting previous VSS snapshots. The program is equipped with special
algorithm to prevent this negative effect from occurring.

To configure VSS -compatible mode, follow these steps:

1. Go to the Compatible mode menu.

2. If you prefer not to optimize your VSS-enabled drive, check the Skip VSS enabled volumes box.

If you’d like to optimize your VSS-enabled drive, but want the program to utilize special algorithm
designed for such drives, check the Use VSS compatible mode box.
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Advanced Actions

Under the Advanced actions menu, you can configure the program to perform additional tasks prior
to defragmentation, which will make the defrag process more efficient.

If a disk has errors, it is advisable to find and fix them before proceeding with defragmentation.
Otherwise, data corruption and/or loss may occur.

= To have the program check disks for errors before starting defragmentation, select the Advanced
actions menu and check the box next to Scan disks for errors.

The user’s and Windows’ temporary folders usually accumulate files that are not needed and can be
safely deleted. Defragmenting these files would be a waste of time and space, so it is a good idea to

have such files deleted before starting defragmentation.

= To set the program to delete temporary files prior to defragmentation, check the box next to
Delete temporary files before defragmenting.
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Configuring Optimize by Disk Zone Profile

While the previous two operation types perform optimization by placing files in specific disk zones,
Optimization by Disk Zone takes into consideration more file parameters when sorting files into
different disk zones, thus allowing you to exercise more control over file placement. Here is a brief
overview of the advantages of this type of optimization:

= Optimizes file placement for maximum HDD speed

=  Frequently changed files are placed in the Fast Zone, which makes all operations with such files
go faster

= Rarely changed large files are placed in the Slow Zone (the larger the file, the less effect its
placement in the slow zone has on its read speed). Such files may include large audio files,
videos, etc. This allows to free up space in the fast zone without any speed loss.

= Works for most disks

Following are your menu options when configuring Optimization by Disk Zone:

Operation type: [Optimize by Disk Zone

Optimize by Disk Zone defragments files and allows you to define the disk zone for placine
to optimize access to them.

¥ Fast zone (front of the disk)

¥ Slow zone (back of the disk)

¥ Disk zone parameters Dis
» Prevent Fragmentation Mot
¥ Compatible mode

¥ Advanced actions Mot
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Fast Zone / Slow Zone

You can specify any or all of the frequently used files, folders, registry and system files to be placed in
the fast zone, as well as define additional files for the fast zone. For the slow zone, you can specify
any or all of the audio and video files, archive and disk image files, temporary files, large and rarely
accessed files (you can set the size and the last access time for these files), as well as specify
additional files for placing in this zone. To do this, follow these steps:

1. Go to the Fast zone menu.

2. Check the boxes next to file types you want placed in the fast zone and/or specify your own files
in the blank space separating them with a comma.

3. Do the same under the Slow zone menu.

Disk Zone Parameters

Although it may increase defragmentation time, you can enable file sorting within each zone to
achieve more thorough optimization. To do that, follow these steps:

1. Select the Disk zone parameters menu.

2. Check the Enable file sorting within a zone box to set ascending sort order for optimization by
last access time, or descending sort order for optimization by last change time.

Prevent Fragmentation

To prevent fragmentation, you can leave some space after certain files, which will allow future
writing of data right next to the file and help keep file fragments together. You may want to do this
for files that constantly get data added to them (such as logs, database files, mail client files that are
used to store received messages, etc.).

To specify files after which you would like the program to leave some free space for writing data,
follow these steps:

1. Select the Prevent Fragmentation menu and list the file names separated with a comma in the
Files to be processed box.

2. Specify the amount of free space to be left after each file either as an exact number of bytes, kB
or MB, or as a percentage of the file’s size.
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3. If any of the specified files get rarely modified, you can configure the program not to leave space
next to those files to prevent wasting disk space.

4. To configure the program to skip files that haven’t been modified in a certain number of days
prior to operation, check the appropriate box and set the number of days in the scroll box.

Compatible Mode

When you have VSS-enabled drives (Volume Shadow Copy Service), special care is required for
optimizing such drives. Regular optimization may cause the VSS storage area to grow excessively,
which in turn may lead to overwriting previous VSS snapshots. The program is equipped with special
algorithm to prevent this negative effect from occurring.

To configure VSS -compatible mode, follow these steps:
1. Go to the Compatible mode menu.
2. If you prefer not to optimize your VSS-enabled drive, check the Skip VSS enabled volumes box.

If you’d like to optimize your VSS-enabled drive, but want the program to utilize special algorithm
designed for such drives, check the Use VSS compatible mode box.

Advanced Actions

Under the Advanced actions menu, you can configure the program to perform additional tasks prior
to defragmentation, which will make the defrag process more efficient.

If a disk has errors, it is advisable to find and fix them before proceeding with defragmentation.
Otherwise, data corruption and/or loss may occur.

= To have the program check disks for errors before starting defragmentation, select the Advanced
actions menu and check the box next to Scan disks for errors.

The user’s and Windows’ temporary folders usually accumulate files that are not needed and can be
safely deleted. Defragmenting these files would be a waste of time and space, so it is a good idea to

have such files deleted before starting defragmentation.

=  To set the program to delete temporary files prior to defragmentation, check the box next to
Delete temporary files before defragmenting.
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Configuring an Optimize by Prefetch Layout Profile

The Prefetch module used in Windows keeps track of the code and data accessed during Windows
boot process and application startup, and records a trace file of this activity. This information helps
to speed up these processes in the future by accelerating access to the needed data. Disk Defrag
Professional can use the Prefetch records to optimize file placement on disks for more efficient
access to these files and faster system performance. Here is an overview of this method’s
advantages:

= Optimizes file placement according to records contained in the Prefetch file
=  Most settings are configured automatically for optimal results and do not require user input
= Works for system disk and most hard disk drives that have applications installed on them

To configure this type of optimization, select Optimize by Prefetch Layout as the type of operation
under a defrag profile. The program will configure most settings for this profile automatically, except
for the settings you can specify under the Prevent Fragmentation, Compatible Mode and Advanced
Actions menus:

Operation type: [Optimize by Prefetch Layout

Optimize by Prefetch Layout performs optimization of file placement based on the data
received from the Prefetch system rmodule, which speeds up system loading and applicat
launch.

»  Prevent Fragmentation Mot
¥ Compatible mode

¥ Advanced actions Mot

Prevent Fragmentation

To prevent fragmentation, you can leave some space after certain files, which will allow future
writing of data right next to the file and help keep file fragments together. You may want to do this
for files that constantly get data added to them (such as logs, database files, mail client files that are
used to store received messages, etc.).

To specify files after which you would like the program to leave some free space for writing data,
follow these steps:
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1. Select the Prevent Fragmentation menu and list the file names separated with a comma in the
Files to be processed box.

2. Specify the amount of free space to be left after each file either as an exact number of bytes, kB
or MB, or as a percentage of the file’s size.

3. If any of the specified files get rarely modified, you can configure the program not to leave space
next to those files to prevent wasting disk space.

4. To configure the program to skip files that haven’t been modified in a certain number of days
prior to operation, check the appropriate box and set the number of days in the scroll box.

Compatible Mode

When you have VSS-enabled drives (Volume Shadow Copy Service), special care is required for
optimizing such drives. Regular optimization may cause the VSS storage area to grow excessively,
which in turn may lead to overwriting previous VSS snapshots. The program is equipped with special
algorithm to prevent this negative effect from occurring.

To configure VSS -compatible mode, follow these steps:

1. Go to the Compatible mode menu.

2. If you prefer not to optimize your VSS-enabled drive, check the Skip VSS enabled volumes box.

If you'd like to optimize your VSS-enabled drive, but want the program to utilize special algorithm
designed for such drives, check the Use VSS compatible mode box.

Advanced Actions

Under the Advanced actions menu, you can configure the program to perform additional tasks prior
to defragmentation, which will make the defrag process more efficient.

If a disk has errors, it is advisable to find and fix them before proceeding with defragmentation.
Otherwise, data corruption and/or loss may occur.

= To have the program check disks for errors before starting defragmentation, select Advanced
actions menu and check the box next to Scan disks for errors.
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The user’s and Windows’ temporary folders usually accumulate files that are not needed and can be

safely deleted. Defragmenting these files would be a waste of time and space, so it is a good idea to
have such files deleted before starting defragmentation.

To set the program to delete temporary files prior to defragmentation, check the box next to
Delete temporary files before defragmenting.
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Configuring Resource Profiles

Defragmentation and optimization are resource-intensive processes. When you have other processes
and applications that use a lot of system resources and that may run simultaneously with
defragmentation, it makes sense to configure allocation of resources for their most efficient use and
to prevent application conflicts.

The default resource usage profile that is activated when an operation is launched is Balanced
Profile. It is set to automatically detect the current CPU and disk load and to adjust operation
restrictions accordingly.

You can change the default resource profile, as well as configure additional profiles in Resource
Profile settings. To configure resource profiles, follow these steps:

1. Go to Settings > Resource Profiles.
Alternatively, when the Disks or Resource tabs are activated in the main pane, you can access

-

these functions by clicking on the Resource Profiles button in the main pane menu.

2. Inthe window that appears, choose the profile you would like to customize from the list on the
left, or click the New button at the top to create a new profile.

.
a Auslogics Disk Defrag Professional: Resource Profile
Bk New 5 Copy W' Default Disable X Delete
Show Mame
4 Mame
v’ default Balanced
W active Low Priority
W' active Normal Priority Unique profile name:
W active High Priority .
It is recommended to select
recognize it in the future an

3. Inthe right pane, select a meaningful name for your profile that will help you recognize it in the
future.
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4. Clicking on the Processor, Drive, Battery or Applications tabs below the profile name will open
additional lists of settings that you can configure for each resource profile:

4 Mame B
Unique profile name: Balanced
It is recommended to select a unique meaningful name for a profile name. This will help

recognize it in the future and allow easier profile list management.

»  Processor Automatical
¥ Drive Automatical
¥ Battery Mot
¥ Applications Applications not dete

5. When you are done changing these settings, you can set the profile status by clicking the
corresponding button at the top — you can choose Default (only one profile can have this status),
or Enable/Disable to make the profile active or inactive. Profiles with the Active status will be
displayed in the drop-down list of the Resource tab and can be easily launched from the
program’s main window.

g Auslogics Disk Defrag Professional: Resource Profile

B Mew 5 Copy W' Default Disable X Delet

Show MName
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Configuring Processor Load

To configure the load on the processor by defragmentation operations, click on the Processor menu.
Here you will need to select one of four options:

= Checking Without restriction will allow the defragmentation process to use CPU resources
without any restrictions.

= Checking Automatically detect will tell the program to impose some restrictions on CPU use that
would give the defragmentation process enough resources while limiting its impact on other
applications. This option is recommended, as it provides the most flexibility and adjusts better to
current situation.

= You can also choose High load, Average load or Minimum load from the list by checking Choose
a value from the list, which will restrict processor use to no more than 90%, 50% or 10%
respectively.

= Alternatively, you can set a restriction as an exact percentage of the load by selecting Load no
more than (%) and specifying a number in the scroll box.

Configuring Drive Load

Under the Drive menu, you can configure the maximum load allowed to be created by the
defragmentation process on the disk drive. Select Without restriction if you prefer not to set any
restrictions; select Automatically detect to have the program set the most suitable restriction
automatically; or set your own exact restriction as a Mb/s amount.

Adjusting to Battery Levels

For computers that use battery power (laptops, netbooks, etc.), you can configure the
defragmentation process behavior to adjust to different battery levels. The program will
automatically detect current battery level and operate in the mode you specify for the resource
profile in use. To configure program behavior according to different battery levels, select the Battery
menu. For each of the three battery levels listed (Normal — more than 66%, Average — 33% to 66%,
and Low — less than 33%), select what you want the program to do from the drop-down list. The
options here are: Without changes, Reduce activity, Pause or Stop the process.
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Preventing Application Conflicts

Some applications, when they run simultaneously, may interfere with the defragmentation process
or cause errors. Disk Defrag Professional allows you to specify such applications and configure what
you want the program to do when such an application is launched or is already running when the
defrag process is set to start. To configure these settings, follow these steps:

1. Go to the Applications menu.

2. Under the blank space reserved for the list of applications, click the Browse button and select the
application you'd like to create rules for.

3. When the application path appears in the line to the left of the Browse button, click the Add
Application button. The application will appear in the list above.

4. Repeat these steps if you need to add more applications to the list.

5. When you are done adding applications to the list, you need to indicate what you want the
program to do if one of the specified applications is launched while the defragmentation process
is already underway. You can set the program to pause the operation or stop it by selecting the

appropriate option below the list.

To remove an application from the list, select it in the list and click the Delete Selected button below.
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Scheduling Tasks

In order to keep disk fragmentation in check and support good system health and consistent speed, it
is important to run defragmentation and optimization regularly. Launching defragmentation
manually when you remember to does not provide the level of maintenance needed for best results.
This is why, in addition to the Defrag Wizard that lets you schedule some tasks, Disk Defrag
Professional comes equipped with the Scheduler tool that provides a wide array of options you can
configure for scheduling several types of defragmentation and optimization. The Scheduler allows
you to configure Defragmentation by Time, Auto Defragmentation and Offline Defragmentation.

Note. In this section, as well as within the Scheduler tool in the program, the term
“Defragmentation” is used to signify any of the following operations: simple
defragmentation, free space consolidation, any type of optimization. When scheduling a task,

you can select the defrag profile with the type of operation you’d like to use for the task.

Here is a brief overview of each of these three methods:

Defragmentation by

. Auto Defragmentation
Time

Offline Defragmentation

=  Runs at the specified =

time even when the
program is not running

=  Runsin the background
and does not interfere
with other user activity

= (Canputaniconin
notification area to
show when the
operation is underway

Runs when system remains =

idle for a specified period
of time, and only when the
program is running

Stops when user resumes
activity on the computer

Can be set not to run too
frequently to prevent
excessive launches

Runs at boot time, before
the operating system loads

Is used to defragment
system files and other files
that are locked during
normal system operation
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Scheduling Defragmentation by Time

Defragmentation by Time, also referred to in the program as Scheduled Defragmentation, is
designed to run exactly at the specified time, regardless of whether the program is running. To
configure Defragmentation by Time, follow these steps:

1. Click on the Scheduler tab in the main pane menu.

2. Click on Defragmentation by Time right above the tasks list.

Alternatively, you can click on the arrow in the Scheduler tab and select Schedule Time... from
the drop-down list:

e

Reports - 17 Scheduler - - E=

) Schedule Time...

can manage the li esults of the last run.
Schedule Auta...
nentation by Tim Schedule Offline efragmentation
Run Conditions Enabled State Last Result

(C:) Ewvery Sunday at 11:00:00 PM inactive disabled

3. Inthe window that pops up, fist select the disks that you want to enable this task for by checking
the boxes next to the disks' names.

4. Then click on the Profiles menu and select the defragmentation and resource profiles you want
to use for this task from the drop-down lists.

Note. The lists will show all defragmentation and resource profiles that are marked as active. If you
don’t see the profile you want in the list, check to make sure it is set as active in the Defrag
Profile or Resource Profile settings (see Confiquring Defraq Profiles or Configuring Resource
Profiles). You can also check or change profile settings by clicking on the Configure link to the
right of the drop-down box in the Defrag by Time scheduler window.

5. To specify the time when you want this task launched, click on the Run Conditions menu. Specify
the frequency, as well as day and exact start time for the task.
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Proceed to the Extended Parameters menu to set additional conditions for the task. Here you
can temporarily disable the task by unchecking the box next to Task Enabled - this will save all
task parameters and allow you to enable the task in the future without having to go through
configuring it anew.

You can also set the program not to launch the operation under this task when fragmentation
hasn’t reached a certain point. This will prevent defragmentation from being launched when it is
not really necessary and from adding unnecessary load on system resources. To do this, check
the appropriate box and set the fragmentation percentage up to which the task will not be
launched.

For your convenience, you can have an icon displayed in the Windows notification area when a
scheduled task is running (this option is checked by default). If you prefer not to see an icon in

the notification area, uncheck the appropriate box under the Extended Parameters menu.

When you are done configuring the task, click OK at the bottom of the window. This will place
the task in the list of scheduled tasks, which you can view under the Scheduler tab.
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Scheduling Auto Defragmentation

Auto Defragmentation is launched only when the program is running. It is designed to work in the
background for constant disk maintenance. It can be configured to start when the system remains
idle for a period of time from 1 to 30 minutes, and to stop when a user resumes activity on the
computer. To avoid having your disk defragmented too frequently, you can set the task to be started
no more than once in a period of time from 3 to 24 hours.

1. To schedule Auto Defragmentation, click on the Scheduler tab in the main pane menu.
2. Right above the tasks list, click on Auto Defragmentation.

As an alternative, you can click on the arrow in the Scheduler tab and select Schedule Auto...
from the drop-down list:

B

R 2
hd 17 -E[I Resource - E=

Scheduler -

Reports

) Schedule Time...
can manage the li esults of the last run.
Schedule Auto...

g e Schedule Offline...

efragmentation

Run Conditions Enabled State Last Result
(C:) Ewvery Sunday at 11:00:00 PM inactive disabled

3. Inthe window that pops up, select the disk you would like to schedule this task for. To do that,
check the box next to the disk name in the list of disks.

4. Now, click on the Profiles menu and select the defragmentation and resource profiles you would
like to use for this task. If you need to change any profile settings, click on the Configure link to
the right of the drop-down boxes.

5. Continue to the Run Conditions menu and set the time the system has to be idle for before this
task is launched, and the maximum frequency of this task in a 24-hour period.

6. Under the Extended Parameters menu, you can temporarily disable the task while saving its
settings, which will allow you to enable the task in the future. To do this, uncheck the box next to
Task Enabled.

7. Here you can also set the program not to launch the task if disk fragmentation hasn't reached
specified percentage. To do this, check the appropriate box under the Extended Parameters
menu and specify the fragmentation percentage up to which the task will not be launched.

8. When you are done, click OK to save the task and put it in the list of scheduled tasks, which is
available under the Scheduler tab in the main pane.
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Scheduling Offline Defragmentation

There are system files that are locked during normal system operation and cannot be defragmented
with regular defragmentation algorithms. This usually includes MFT files, Windows Paging and
Hibernation files, as well as registry files. At the same time, these files can get heavily fragmented
and contribute a lot to the overall disk fragmentation. Offline Defragmentation is a special engine
that takes care of such files by defragmenting them at boot time, before the operating system loads.

1. To schedule Offline Defragmentation, click on the Offline Defragmentation link above the
scheduled tasks list under the Scheduler tab.

Alternatively, you can click on the arrow on the Scheduler tab and select Schedule Offline Defrag
from the drop-down list:
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2. Inthe window that pops up, select the disk for which you would like to schedule this task by
checking the box next to the disk name.

3. The program allows you to specify which system files you would like to defragment. To do that,
click on the Items Being Processed menu and check the boxes next to the files you would like to

include for defragmentation.

4. Then, decide whether you want this task to run once at next boot or on every boot by checking
the appropriate box under the Run Conditions menu.

5. The Extended Parameters menu allows you to temporarily disable the task while preserving its
settings, which can be done by unchecking the box next to Task Enabled.

6. When you are done, click OK to save the task and put it in the scheduled tasks list.

SCHEDULING TASKS



Working with the Scheduled Tasks List

All of the tasks scheduled while using the Defrag Wizard or through the Scheduler are available in
the list of scheduled tasks. To access the list, click on the Scheduler tab in the main pane menu.

The list of scheduled tasks is displayed in the top part of the main pane, with a summary of the last
operation results displayed in the bottom part.
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Right above the summary, there are quick links that allow you to skip to the disk details in the
summary by clicking on the disk name.

On the right, you will see a calendar that has dates with scheduled or m

executed tasks circled on it. If you'd like to view tasks scheduled for a S M T WT F §
particular date, click on that date on the calendar, and the tasks will 1 2 3 4 5 § 7
be displayed in the list. To select the current date, click on Today 8 9 10 11 )13 14
under the calendar - this will display all tasks scheduled for the 15 16 17 18 19 20 21
current date. To return to viewing all tasks, click on the Show all tasks 2 @@@@@@
link under the calendar. You can view history of task execution by @eEHED

scrolling through calendar months using the arrows in the top left and

right corners of the calendar. Show all tasks

You can sort the list by various parameters by clicking on column headers.

=l

To edit a task's parameters, select the task in the list and click Edit in the main pane menu.

You can also create additional tasks with similar parameters to existing tasks. To do that, select a task

from the list and click the E Copy button in the main pane menu. This will open the task settings
window, where you can adjust the settings and save the task as described earlier in this section.
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To delete a task from the list, select it and click & Delete in the main pane menu.

Note. This will completely remove the task. If you only want to disable the task temporarily, but
save its settings for future use, you can do that by clicking the Edit button and unchecking the
Task Enabled box under the Extended Parameters.

You can also launch a task from the list by selecting it and clicking the o Run button in the main
pane menu. This function is not available for Offline Defragmentation, since this type of
defragmentation only runs at boot time.

SCHEDULING TASKS



Program Reports

The program provides detailed reports on all defragmentation and optimization operations with
capabilities to print reports and save them in one of three formats.

Viewing Reports

To view a report immediately after an operation completes, click on the View Detailed Report in the
operation results.

To view all or specific reports, click on the Reports tab. This will display a list of all available reports
with a summary of the last report shown in the bottom part of the window.
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To see reports for a specific date only, select the date on the calendar on the right. All reports
available for that date will be listed in the main window. To clear the date selection and return to
viewing all available reports, click on Show all reports in the bottom part of the calendar.

To view a specific report, select it in the list of reports and its summary will be displayed in the
bottom part of the window.

. . . . . )
To see more details on the selected report, click View right above the summary, or click the = *

View button in the main pane menu. This will open the detailed report in your default internet
browser.

There is also an option to generate a full system report that will show details of all disks in your
system with their specs and a list of system folders. To generate and view a system report, under the

Reports tab, click System Report right above the reports list, or click the E System Report button
in the main pane menu. This will generate a system report and display it in your default internet
browser. The report will also appear in the reports list and will be available for viewing, printing and
saving.

PROGRAM REPORTS m



Printing Reports

To print a report, follow these steps:
1. Click on the Reports tab.

2. Select a report from the list and click Print right above the report summary, or click the

== Print button in the main pane menu. This will automatically send the report to your default
printer.

Saving and Storing Reports

By default, the program generates and stores reports in .xml format. In addition to that, you can save
reports in one of three available formats - .xml, .html or .txt - in a folder that is convenient for you.
To save a report, follow these steps:

1. Click on the Reports tab.

2. Select the report you would like to save - report summary will be displayed in the bottom part of
the program window.

3. Click the Save As link right above the summary, or click the = Save As button in the main
pane menu.

4. Inthe window that appears, select the destination folder and a file name.
5. Select the file format from three available options - .xml, .html or .txt - and hit Save.

6. The selected report will be saved in the specified folder. You can access it by navigating to that
folder using Windows Explorer.

Reports that you save manually in a folder other than the program default folder are stored
indefinitely (until you delete them). Reports automatically saved by the program in the default folder
are stored for a specified period of time to prevent the reports storage folder from growing
excessively.
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The report storage life is, by default, set to 10 days, which means that reports are stored for 10 days
after being generated, and are deleted after this period. You can change report storage preferences
in Program Settings. To do that, follow these steps:

1. Inthe main menu select Settings > Program Settings.

2. Inthe window that appears, select the General tab.

3. Specify the desired number of days you would like your reports saved for and click OK.

PROGRAM REPORTS



Configuring Program Settings

The Program Settings manager allows you to change the program’s language, looks and behavior,
tweak algorithms and set exclusions. To launch the Program Settings manager, select Settings >
Program Settings from the Program’s main menu. A new window will appear, with settings divided
into six categories: Language, General, Integration, Cluster Map, Algorithms and Exclusions.

ﬂ Settings g

Language | General I Integration | Cluster Map | Algorithms El(clusions|

Changing Language

By default, the program is installed in your operating system language, or in English, if your OS
language is not supported. To change the program language, follow these steps:

1. Select Settings > Program Settings from the main menu.
2. Click on the Language tab and select the desired language from the drop-down menu.

3. When you are done, click OK, or proceed to another tab if you need to change other program
settings.

Note. Please keep in mind that changing program language requires you to restart the application
for the changes to take effect.

CONFIGURING PROGRAM SETTINGS



General Settings

The General tab is where you can specify the program’s behavior (whether you want it to start at
Windows logon or be minimized on close), and specify reports and statistics storage life. To change
any of these settings, follow these steps:

1. Select Settings > Program Settings from the main menu.

2. Click on the General tab and make the desired changes.

3. When you are done, click OK, or proceed to another tab if you need to change other program
settings.

Integration

The Integration tab allows you to choose the level of the program’s integration into the Windows
shell. You can choose to integrate the program into Windows Explorer, which will add "Defragment
with Disk Defrag Professional” to its context menu. This will let you defragment files, folders or
drives by right-clicking on them in Windows Explorer and selecting the required option from the
menu.

Here you can also choose to disable the standard Windows Defrag utility, which will help reduce
unnecessary load and wear on your drives.

The third Integration option is to use Auslogics Disk Defrag Professional as your default
defragmentation utility instead of standard Windows Defrag.

To change any of these settings, follow these steps:
1. Select Settings > Program Settings from the main menu.
2. Click on the Integration tab and make the desired changes.

3. When you are done, click OK, or proceed to another tab if you need to change other program
settings.

CONFIGURING PROGRAM SETTINGS



Cluster Map Appearance

Under the Cluster Map tab, you can specify the way your cluster map will look in the program
window. To change these settings, follow these steps:

1. Select Settings > Program Settings from the main menu, and click on the Cluster Map tab.
2. Inthe first drop-down menu, choose between bars or squares for displaying cluster blocks.
3. Inthe next drop-down menu, select one of 12 color schemes for the cluster map.

4. Under the cluster map preview screen, you can check the box if you want the speed zones to be
marked on the map, or uncheck the box not to show the speed map.

5. When you are done, click OK, or proceed to another tab if you need to change other program
settings.

Tweaking Algorithms

The Algorithms tab allows you to tweak defragmentation algorithms.

You can set the program to skip files or fragments larger than a certain size, since defragmenting very
large files or fragments doesn’t serve any practical purpose.

You can also set SSD (Solid-State Drives) not to be displayed in the drives list, or mark a certain drive
as an SSD drive, if it was not properly detected by the program.

To change any of these settings, follow these steps:
1. Select Settings > Program Settings from the main menu and click on the Algorithms tab.

2. To have the program skip large fragments or files, check one or both of the first two boxes, then
set the minimum size for fragments or files to be skipped from the drop-down menu.

3. To have SSD drives excluded from the drives list, check the Do not show SSD drives box.

4. If you have a Solid-State Drive that was not identified as such, and you want it marked properly in
the drives list, check the box next to the drive’s name in the list.

5. When you are done, click OK, or proceed to another tab if you need to change other program
settings.
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Specifying Exclusions

Under the Exclusions tab, you can specify files or folders that you do not want the program to
defragment. To do that, follow these steps:

1. Select Settings > Program Settings from the main menu and click on the Exclusions tab.
2. Click on the Add... button and browse your computer for the needed items.
3. When you are done adding items to the list, click OK.

To remove a file or folder from the list of exclusions, select the item from the list and click Delete.

CONFIGURING PROGRAM SETTINGS



Troubleshooting

Some Files Skipped by the Program
When viewing operation results, you may notice that some files were skipped by the program. This
can happen for several reasons:

= When you have other applications running while defragmentation is underway, some files may
be used by those applications and locked because of that. A solution to this problem is to close
all other applications and restart defragmentation.

= Some system files may be in use by the system and locked because of this. A solution to this
problem is scheduling offline defragmentation, which will run at boot time and defragment files
that are locked during normal system operation.

=  The program may be unable to defragment large files and skip them due to there not being
enough contiguous free space to put the whole file. Although your disk may have plenty of free
space, it may be fragmented into sections that are not large enough for some bigger files. A
solution to this problem is to run free space consolidation and repeat defragmentation after that.

Free Space Not Found Error

When viewing operation results, you may see a Free Space Not Found error. It does not mean that
your disk is out of free space, it usually means that the program was unable to find contiguous
sections of free space to place some defragmented files. The most common cause of such errors is
free space fragmentation. The best solution is to run free space consolidation and then repeat
defragmentation.

Disk Still Fragmented After Running Defragmentation

When you first start using the program, especially if you haven't defragmented your drives in a long
time, you may notice that your disks are still fragmented after running standard defragmentation.
This most commonly happens with the system disk, and the most common cause of this problem is
presence of a lot of fragmented system files that are locked during normal system operation. The
best solution for this problem is to schedule offline defragmentation for the next boot, which will
defragment system files and should significantly reduce disk fragmentation.

TROUBLESHOOTING



Glossary

Access

As used in relation to file access, the term signifies
an instance of a file read request initiated by the
user or the system. Last Access Time is the last
instance of a file read request prior to the current
moment.

Archive

An archive file is a file that is composed of one or
more files along with metadata that can include
source volume and medium information, file
directory structure, error detection and recovery
information, file comments, and usually employs
some form of lossless compression. Archive files
may also be encrypted in part or as a whole.
Archive files are used to collect multiple data files
together into a single file for easier portability and
storage.

Auto Defragmentation

The term Auto Defragmentation is used in the
program to signify any type of operation, such as
defragmentation, optimization or free space
consolidation, which is scheduled to start
automatically when the system remains idle for a
specified period of time, and to stop when user
activity is detected. Auto Defragmentation runs
only when the program is running.

Boot

In computing, booting (also known as "booting
up") is a bootstrapping process that starts
operating systems when the user turns on a
computer system. A boot sequence is the initial set
of operations that the computer performs when
power is switched on. The boot loader typically
loads the main operating system for the computer.

Change

Change, as used in the phrase Last Change Time,
signifies any type of file modification (such as
editing, adding or deleting data, renaming, etc.)
initiated by the user. Last Change Time refers to
the last instance of such file modification as
registered in the system.

Cluster

In computer file systems, a cluster is a unit of disk
space allocation for files and directories. A cluster
can consist of one or more consecutive sectors.
The number of sectors is always an exponent of 2.
A cluster could consist of 1 sector (220), or, more
frequently, 8 sectors (23). The only odd number
of sectors a cluster could consist of is 1. It could
not be 5 sectors or an even number that is not an
exponent of 2. It would not be 10 sectors, but
could be 8 or 16 sectors.

Consolidation
Consolidation is defined as the act of combining
into an integral whole.

CPU

The central processing unit (CPU) is the portion of
a computer system that carries out the instructions
of a computer program, and is the primary
element carrying out the computer's functions.
The central processing unit carries out each
instruction of the program in sequence, to perform
the basic arithmetical, logical, and input/output
operations of the system. This term has been in
use in the computer industry at least since the
early 1960s. The form, design and implementation
of CPUs have changed dramatically since the
earliest examples, but their fundamental operation
remains much the same.

Database

A database is a system intended to organize, store,
and retrieve large amounts of data easily. It
consists of an organized collection of data for one
or more uses, typically in digital form. One way of
classifying databases involves the type of their
contents, for example: bibliographic, document-
text, statistical. Digital databases are managed
using database management systems, which store
database contents, allowing data creation and
maintenance, and search and other access.



Defragment

In the context of administering computer systems,
defragmentation is a process that reduces the
amount of fragmentation in file systems. It does
this by physically organizing the contents of the
disk to store the pieces of each file close together
and contiguously. It also attempts to create larger
regions of free space using compaction to impede
the return of fragmentation. Some defragmenters
also try to keep smaller files within a single
directory together, as they are often accessed in
sequence. The movement of the hard drive's
read/write heads over different areas of the disk
when accessing fragmented files is slower,
compared to accessing a non fragmented file in
sequence, without moving the read/write heads.

Defragmentation by Time

The term Defragmentation by Time, same as
Scheduled Defragmentation, is used in the
program to signify any type of operation, such as
defragmentation, optimization or free space
consolidation, which is scheduled to start at a
specified time, regardless of whether the program
is running.

Defragmentation Profile

The term Defragmentation Profile is used in the
program to describe a combination of settings
configured for a defragmentation or optimization
operation and intended to be used when
scheduling tasks or starting defragmentation. It is
possible to configure multiple defragmentation
profiles, and then select one profile for each task
being scheduled or launched.

Disk Drive

Disk storage or disc storage is a general category of
storage mechanisms, in which data are digitally
recorded by various electronic, magnetic, optical,
or mechanical methods on a surface layer
deposited of one or more planar, round and
rotating platters. A disk drive is a device
implementing such a storage mechanism with fixed
or removable media; with removable media the
device is usually distinguished from the media as in
compact disc drive and the compact disc. Notable
types are the hard disk drive (which contain a non-
removable disc), the floppy disk drive and its
removable floppy disk, various optical disc drives
and associated media.

Disk Image

A disk image is a single file or storage device
containing the complete contents and structure
representing a data storage medium or device,
such as a hard drive, tape drives, floppy disk,
CD/DVD/BD and key drive, although an image of an
optical disc may be referred to as an optical disc
image. A disk image is usually created by creating a
complete sector-by-sector copy of the source
medium and thereby perfectly replicating the
structure and contents of a storage device.

Disk Zone

Hard disk tracks are subdivided into zones based
on their distance from the disk center. Although
there may be more than 3 zones, for optimization
purposes an HDD can be subdivided into 3 zones -
the front zone, middle zone and back zone. The
front zone, or the beginning of the disk, provides
the fastest file access time, and therefore is
recommended for placing frequently accessed
files. The back zone has the slowest file access
time; and the middle zone is everything in-
between.



File

A computer file is a block of arbitrary information,
or resource for storing information, which is
available to a computer program and is usually
based on some kind of durable storage. A file is
durable in the sense that it remains available for
programs to use after the current program has
finished. Computer files can be considered as the
modern counterpart of paper documents which
traditionally are kept in office and library files, and
this is the source of the term.

File System

A file system (often also written as filesystem) is a
method of storing and organizing computer files
and their data. Essentially, it organizes these files
into a database for the storage, organization,
manipulation, and retrieval by the computer's
operating system.

Filename

The filename is metadata about a file; a special
kind of string used to uniquely identify a file stored
on the file system of a computer. Some operating
systems also identify directories in the same way.
Different operating systems impose different
restrictions on length and allowed characters on
filenames.

Hard Disk

A hard disk drive (HDD) is a non-volatile, random
access device for digital data. It features rotating
rigid platters on a motor-driven spindle within a
protective enclosure. Data is magnetically read and
written on the platter by read/write heads that
float on a film of air above the platters.

Hard Drive
See Hard Disk above

Hibernation Mode

Hibernation is functionality allowing a computer to
be turned off completely while maintaining its
state. On switching back on the state is restored to
the way it was, with files open, unsaved data
intact, etc.

Log File

A log file is a computer file, in which

a program records events, such as user access or
data manipulation as they occur, to serve as

an audit trail, diagnostic device,

or security measure.

Metadata

Metadata is loosely defined as data about data.
Metadata is traditionally found in the card catalogs
of libraries and is today commonly used to
describe three aspects of digital documents and
data: 1) definition, 2) structure and 3)
administration. By describing the contents and
context of data files, the quality of the original
data/files is greatly increased. For example, a
webpage may include metadata specifying what
language it's written in, what tools were used to
create it, and where to go for more on the subject,
allowing browsers to automatically improve the
experience of users.

Metafile

Metafile is a generic term for a file format that can
store multiple types of data. This commonly
includes graphics file formats. These graphics files
can contain raster, vector, and type data. A
common use for these files is to provide support
for an operating system's computer graphics.

MFT (Master File Table)

MFT, or Master File Table, is a unique system file
that essentially acts as a database containing
metadata about every file, directory or metafile on
an NTFS volume. It includes filenames, locations,
size, and permissions.



Notification Area

The notification area (also called the system tray) is
the portion of the taskbar that displays icons for
system and program features that have no
presence on the desktop as well as the time and
the volume icon. It contains mainly icons that show
status information, though some programs use it
for minimized windows. By default, this is located
in the bottom-right of the primary monitor (or
bottom-left on languages of Windows that use
right-to-left reading order), or at the bottom of the
taskbar if docked vertically. The clock appears
here, and applications can put icons in the
notification area to indicate the status of an
operation or to notify the user about an event.

NTFS

NTFS (New Technology File System) is the standard
file system of Windows NT, including its later
versions Windows 2000, Windows XP, Windows
Server 2003, Windows Server 2008, Windows
Vista, and Windows 7.

Offline Defragmentation

The term Offline Defragmentation is used in the
program to signify defragmentation that runs at
boot time, before the operating system starts up,
and works by defragmenting system files that are
locked during normal system operation.

Paging File

In computer operating systems, paging is one of
the memory-management schemes by which a
computer can store and retrieve data from
secondary storage for use in main

memory. On Windows NT based systems,
dedicated swap space is known as a page file and
paging/swapping are often used interchangeably.
In NT-based versions of Windows (such

as Windows XP, Windows Vista, and Windows 7),
the file used for paging is named pagefile.sys. The
default location of the page file is in the root
directory of the partition where Windows is
installed.

Prefetch

The Prefetch folder is a subfolder of

the Windows system folder. Each time you turn on
your computer, Windows keeps track of the way
your computer starts and which programs you
commonly open. Windows saves this information
as a number of small files in the Prefetch folder.
The next time you turn on your computer,
Windows refers to these files to help speed the
start process.

Privilege

In computing, privilege is defined as the delegation
of authority over a computer system. A privilege is
a permission to perform an action. Examples of
various privileges include the ability to create

a file in a directory, or to read or delete a file,
access a device, or have read or write permission
to a socket for communicating over the Internet.

Process

In computing, a process is an instance of a
computer program that is being executed. It
contains the program code and its current activity.
Depending on the operating system (OS), a process
may be made up of multiple threads of execution
that execute instructions concurrently.

Processor

The term most commonly refers to a computer’s
Central Processing Unit (CPU). It is the portion of
a computer system that carries out

the instructions of a computer program, to
perform the basic arithmetical, logical,

and input/output operations of the system.

Profile

A profile is a set of data portraying the significant
features of something. It is also defined as a
control file for a program automatically read
from each user's home directory and intended to
be easily modified by the user in order to
customize the program's behavior. Itis

used to avoid hard-coded choices.



Registry

Windows registry is a hierarchical database that
stores configuration settings and options on
Microsoft Windows operating systems. It contains
settings for low-level operating system
components, as well as the applications running on
the platform. The kernel, device drivers, services,
SAM, user interface and third party applications all
make use of the Registry.

Resource Profile

The term Resource Profile is used in the program
to describe a combination of settings configured to
direct usage of system resources by
defragmentation or optimization operations. A
user can configure several resource profiles and
assign different profiles to different
defragmentation tasks.

Scheduled Defragmentation
See Defragmentation by Time

Sector

In computer disk storage, a sector is a subdivision
of a track on a magnetic disk or optical disc. Each
sector stores a fixed amount of user data.
Traditional formatting of these storage media
provides space for 512 bytes (for magnetic disks)
or 2048 bytes (for optical discs) of user-accessible
data per sector. Newer hard drives use 4096 byte
(4KB or "4K") sectors.

Sleep Mode

Sleep mode refers to a low power mode for
electronic devices such as computers, televisions,
and remote controlled devices. These modes save
significant electrical consumption compared to
leaving a device fully on and idle, but allow the
user to avoid having to reset programming codes
or wait for a machine to reboot. Many devices
signify this power mode by a pulsing LED power
light. When placed in this sleep mode, aside from
the RAM, which is required to restore the
machine's state, the computer attempts to cut
power to all unneeded parts of the machine.

Snapshot

In computer systems, a snapshot is the state of a
system at a particular point in time. The term was
coined as an analogy to that in photography. It can
refer to an actual copy of the state of a system or
to a capability provided by certain systems.

Solid State

Solid-state electronics are those circuits or devices
built entirely from solid materials and in which the
electrons, or other charge carriers, are confined
entirely within the solid material. The term is often
used to contrast with the earlier technologies of
vacuum and gas-discharge tube devices and it is
also conventional to exclude electro-mechanical
devices (relays, switches, hard drives and other
devices with moving parts) from the term solid
state.

Solid State Drive (SSD)

A solid-state drive (SSD) is a data storage device
that uses solid state memory to store persistent
data. SSD’s contain no moving parts, but use
microchips that retain data in non-volatile memory
chips.

System Resources

In a computer system, system resources are the
components that provide its inherent capabilities
and contribute to its overall performance. System
memory, cache memory, hard disk space, IRQs and
DMA channels are examples.

Unmovable File

As used in the program, this term refers to files
that could not be defragmented or optimized due
to access being denied to them by the system.
Examples of such files are NTFS service metafiles,
Windows paging file, hibernation file, and other
system files that are locked or in use by the system
or by certain applications.



Volume

In the context of computer operating systems,
volume is the term used to describe a single
accessible storage area with a single file system,
typically (though not necessarily) resident on a
single partition of a hard disk. Similarly, it refers to
the logical interface used by an operating system
to access data stored on some media using a single
instance of a filesystem. "Volume" can be used in
place of the term "drive" where it is desirable to
indicate that the entity in question is not a physical
disk drive, but rather the corporate data stored
using a filesystem there. "Logical drive" and
"volume" should be considered synonymous;
however "volume" and "partition" are not
synonymous.

VSS

VSS (Volume Shadow Copy

Service, Volume Snapshot Service) is a backup &
restore function in Windows that makes copies of
volumes (hard disks, etc.). VSS works stand alone
within the OS; for example, starting with Windows
Server 2003, it is used to create incremental
backups of a volume. In Windows Server 2008,

a disk shadow utility was added to allow VSS
operations to be scripted. Also available in
Windows client versions starting with Windows XP,
VSS can be activated by third-party backup
software.

For any further help, please visit our technical support web page.

Auslogics Software Pty Ltd
PO Box 1644
Crows Nest NSW 1585

Australia

Fax: +61 2 8088 6395



http://www.auslogics.com/en/support/product/disk-defrag-pro/
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